Version 16

New Features in JMP 16

“The real voyage of discovery consists not in seeking new landscapes, but in having new eyes.”

Marcel Proust

JMP, A Business Unit of SAS
SAS Campus Drive
Cary, NC 27513

New Features in JMP® 16
Copyright © 2020–2021, SAS Institute Inc., Cary, NC, USA
All rights reserved. Produced in the United States of America.

U.S. Government Restricted Rights Notice: Use, duplication, or disclosure of this software and related documentation by the U.S. government is subject to the Agreement with SAS Institute and the restrictions set forth in FAR 52.227-19, Commercial Computer Software-Restricted Rights (June 1987).


SAS® and all other SAS Institute Inc. product or service names are registered trademarks or trademarks of SAS Institute Inc. in the USA and other countries.® indicates USA registration.

Other brand and product names are trademarks of their respective companies.

SAS software may be provided with certain third-party software, including but not limited to open-source software, which is licensed under its applicable third-party software license agreement. For license information about third-party software distributed with SAS software, refer to http://support.sas.com/thirdpartylicenses.
Get the Most from JMP

Whether you are a first-time or a long-time user, there is always something to learn about JMP.

Visit JMP.com to find the following:

- live and recorded webcasts about how to get started with JMP
- video demos and webcasts of new features and advanced techniques
- details on registering for JMP training
- schedules for seminars being held in your area
- success stories showing how others use JMP
- the JMP user community, resources for users including examples of add-ins and scripts, a forum, blogs, conference information, and so on

https://www.jmp.com/getstarted
New Features in JMP 16

General Enhancements ................................................................. 9
Add-In Builder .............................................................................. 9
Application Builder ...................................................................... 10
Axis .............................................................................................. 10
Column Switcher ......................................................................... 10
Dashboard Builder ....................................................................... 11
Data Filter ..................................................................................... 11
Data Table .................................................................................... 11
Display Box Properties ................................................................. 12
Formula Editor ............................................................................ 13
Hover Labels ................................................................................ 13
Import and Export ....................................................................... 13
Interactive HTML ..................................................................... 13
Journals ....................................................................................... 14
Making Binning Formula ............................................................... 14
Preferences .................................................................................. 15
Projects ....................................................................................... 15
Recode .......................................................................................... 16
Sample Data ................................................................................ 16
Tabulate ........................................................................................ 17
Tools ............................................................................................. 17
Transform Columns ...................................................................... 17
JMP Live ....................................................................................... 17
Basic Analysis .............................................................................. 18
Distribution ................................................................................ 18
Oneway ....................................................................................... 18
Text Explorer .............................................................................. 18
Graphing ...................................................................................... 19
Graph Builder ............................................................................. 19
Ternary Plot ................................................................................ 21
Treemap ...................................................................................... 21
Profilers ....................................................................................... 21
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profiler</td>
<td>21</td>
</tr>
<tr>
<td>Design of Experiments</td>
<td>21</td>
</tr>
<tr>
<td>Fitting Linear Models</td>
<td>22</td>
</tr>
<tr>
<td>Generalized Regression</td>
<td>22</td>
</tr>
<tr>
<td>Mixed Model</td>
<td>22</td>
</tr>
<tr>
<td>Standard Least Squares</td>
<td>23</td>
</tr>
<tr>
<td>Predictive and Specialized Modeling</td>
<td>23</td>
</tr>
<tr>
<td>Boosted Tree</td>
<td>23</td>
</tr>
<tr>
<td>Explore Missing</td>
<td>23</td>
</tr>
<tr>
<td>Explore Outliers</td>
<td>23</td>
</tr>
<tr>
<td>Explore Patterns</td>
<td>23</td>
</tr>
<tr>
<td>Fit Curve</td>
<td>23</td>
</tr>
<tr>
<td>Make Validation Column</td>
<td>24</td>
</tr>
<tr>
<td>Model Comparison</td>
<td>24</td>
</tr>
<tr>
<td>Model Screening</td>
<td>24</td>
</tr>
<tr>
<td>Nonlinear</td>
<td>24</td>
</tr>
<tr>
<td>Predictor Screening</td>
<td>24</td>
</tr>
<tr>
<td>Process Screening</td>
<td>24</td>
</tr>
<tr>
<td>Response Screening</td>
<td>25</td>
</tr>
<tr>
<td>Support Vector Machines</td>
<td>25</td>
</tr>
<tr>
<td>Time Series</td>
<td>25</td>
</tr>
<tr>
<td>Time Series Forecast</td>
<td>25</td>
</tr>
<tr>
<td>Multivariate Methods</td>
<td>26</td>
</tr>
<tr>
<td>Discriminant</td>
<td>26</td>
</tr>
<tr>
<td>Factor Analysis</td>
<td>26</td>
</tr>
<tr>
<td>Partial Least Squares</td>
<td>26</td>
</tr>
<tr>
<td>Structural Equation Models</td>
<td>26</td>
</tr>
<tr>
<td>Quality and Process Platforms</td>
<td>27</td>
</tr>
<tr>
<td>Control Chart Builder</td>
<td>27</td>
</tr>
<tr>
<td>CUSUM Control Charts</td>
<td>28</td>
</tr>
<tr>
<td>EWMA Control Charts</td>
<td>28</td>
</tr>
<tr>
<td>Measurement Systems Analysis</td>
<td>28</td>
</tr>
<tr>
<td>Model Driven Multivariate Control Charts</td>
<td>28</td>
</tr>
<tr>
<td>OC Curves</td>
<td>28</td>
</tr>
<tr>
<td>Reliability and Survival</td>
<td>28</td>
</tr>
<tr>
<td>Fit Life by X</td>
<td>29</td>
</tr>
<tr>
<td>Life Distribution</td>
<td>29</td>
</tr>
<tr>
<td>Parametric Survival</td>
<td>29</td>
</tr>
<tr>
<td>Reliability Block Diagram</td>
<td>29</td>
</tr>
<tr>
<td>Reliability Growth</td>
<td>29</td>
</tr>
</tbody>
</table>
New Features

Contents

Repairable Systems Simulation .................................................. 29
Consumer Research ................................................................. 30
Scripting .................................................................................. 30
This document describes specific updates to JMP 16. For an overview of the major new features in JMP 16 and information about how to get the release, visit https://www.jmp.com/jmp16.

**General Enhancements**

This section describes basic enhancements to JMP. For details, see the *Using JMP* book.

- The Enhanced mode for the Log window provides a detailed view of the actions taken in the current JMP session and makes it easier to create a script to reproduce those actions.
- Customize date-time formats by defining format patterns that are not provided in JMP. Right-click the column and select Column Info. Select Format Pattern from the Format list. Click Set Format Pattern and then define the pattern.
- When you upgrade to JMP 16 Subscription, changes to preferences are maintained.
- Confusion rates are now included with the confusion matrix in many platforms.
- Extrapolation Control, which helps identify and avoid possible extrapolated predictions, is now available in the prediction profiler that is embedded in many modeling platforms. It is available in Fit Least Squares, Generalized Regression, Neural, Naive Bayes, Support Vector Machines, Partial Least Squares, and Structural Equation Models.
- Extrapolation Control, which helps identify and avoid possible extrapolated predictions, is now available through the general graph profiler using saved prediction formula columns.
- JMP 16 and JMP Pro 16 require at least macOS 10.14 Mojave.
- When you select text, the background color is now the selection color. The text color stays the same (as long as the text color provides enough contrast with the selection color).
- Reports that include tabs record the current tab number when you save the script for the report.

**Add-In Builder**

- Add-In Builder supports customized toolbar items.
Application Builder

- Applications support the Column Switcher. Drag the Column Switcher icon from the Sources panel onto the application workspace.
- Module stretching properties have been removed from applications. All display boxes have stretch, minimum, and maximum properties. There is no change to box stretching, only to the properties shown in Application Builder.

Axis

- Press Ctrl and click a variable on a categorical axis. Then you can drag the variable on the axis to rearrange the variables. Press Shift, click, and drag to rearrange multiple variables. The Value Order column property updates, and the platform is rerun. Right-clicking the variable and selecting Edit Value Order is another way to edit the Value Order column property.
  When you click the label and edit it, the Value Label column property updates.
- To color separate Y axes differently, right-click the graph and select Show Properties. Click the axis that you want to color and change the background color, text color, and line color.
- The Axis Settings window provides options to change the color, font, axis side, and position of reference lines.
- You can change the label alignment for reference lines. Right-click the graph and select Show Properties. Select the axis that shows the labels. Change the Label Alignment to Far (labels are on the far side of the axis), Near (labels are near the axis), or Center (labels are centered).
- Angled labels can be truncated if they reach the edge of the graph frame.
- When you click an axis, the right-click menu includes a Revert Scale option, which lets you revert scale-specific items: min, max, major, interval, and n minor.
- To change the color of tick marks, right-click the graph and select the Line Color option in the appropriate Axis Label Row outline.

Column Switcher

- Column Switcher preferences are available in the Preferences window. Scroll down to the Column Switcher group.
- Column Switcher provides the ability to run a script after the column switch is complete.
- In the Column Switcher red triangle menu, selecting Retain Axis Settings maintains axis customizations when columns are switched.
New Features

Highlights in JMP 16

General Enhancements

• Click the Looping button in the Column Switcher to specify the behavior of the animation when it reaches the last column in the Columns list.

• If a report has multiple column switchers, you can adjust the layout of the column switchers using the Layout options in the Column Switcher red triangle menu.

Dashboard Builder

• Dashboards support the Column Switcher. Drag the Column Switcher icon from the Sources panel onto the dashboard workspace.

Data Filter

• For filtering unstructured text, case sensitivity and regular expressions are available. Also, display options are available from the local data filter red triangle menu to show a list display, single category display, check box display, or radio box display.

• In the local data filter animation controls, the Looping button specifies the behavior of the animation when it reaches the last column in the Columns list.

• The Set Number of Bins red triangle menu option enables you to set the number of bins for a continuous filter item.

• You can now share a local data filter among reports. Select Copy Local Data Filter on the Data Filter red triangle menu. In the other report, select Paste Local Data Filter from the platform red triangle menu.

• To show a smaller local data filter, deselect Show Counts, Show Modes, or Show Controls from the filter’s red triangle menu.

• You can change the modeling type of a filtered column by selecting Modeling Types from the filter’s red triangle menu and changing the type.

• You can add unstructured text columns to a data filter.

• The vertical reference line for the upper limit of a continuous variable is easier to select in the data filter.

Data Table

• The Tables > Compare Data Tables feature has been updated. Matching columns are easier to read and you’ll find fuzzy compare and data alignment options. You can also link or unlink matching columns.

• The Target Level column property, which is used in logistic regression platforms, is available.
• Data cleaning steps (such as subsetting, manipulating rows and columns, and setting column properties) are now captured in a script. View the log to see the steps.
• The Column Filter on the Columns panel of the data table helps you quickly find columns.
• In the Columns Filter menu in launch windows, new sort options include sorting in descending order and showing the columns in the original order.
• In the column properties, Spec Limits values appear in the same format that is set for the column.
• The Cols > Column Names options enable you to move the first row of data up so that it becomes the column name; move the first row of data up and append it to the column name; or move the first row of data down. You can also choose to recode column names.
• New date-time values include <yyyy>, <yy>, <WW1> (a two-digit week number where week two begins on the first Sunday of the year), <WW2> (week one begins on the first Sunday of the year), <ww>, <DW>, and <dw>.
• In the Summary platform, the Median Absolute Deviation summary statistic is the median of the absolute deviation from the data’s median.
• You can again copy and paste an identical table script into a data table.
• The Use Numerical Ordering preference on the Tables page (on by default) specifies that text containing numbers be sorted in numerical order.
• The Move Columns option specifies where stacked columns are moved to. To Last is the default value.
• You can select a range of histogram bars in the column headers.
• The Tables preferences provide options for coloring and highlighting column header summary graphs, including specifying options by data type.
• You can specify Validation as a preselected column role. A column with this preselected role is automatically specified as a Validation column in launch windows that support Validation columns.
• New options have been added to Rows > Row Selection > Name Selection in Column that let you label the column or label selected rows.
• When you create a combined data table, the name of the original data table is in the Table column of the combined data table.

**Display Box Properties**

• In a JMP window, you can use the selection tool to select a portion of the report or graph and select the formatting from a pop-up window.
• The Show Properties option on right-click menus has been moved from an Edit submenu to the upper menu.
New Features

- Change the outline font and properties by right-clicking the report, selecting Show Properties, selecting the outline, and then changing the font properties for the outline box.

Formula Editor

- When you click the Help button at the top of the Formula Editor window, scripting help on the selected function appears for known functions.

Hover Labels

- If a data table contains several expression columns with images, you can show images from multiple columns in a hover label. Right-click on a graph and select Hover Label > Label Viewer.

- The amount of JSL code generated by preset graphlets has been greatly reduced. Common code has moved to the utility library hlib.jsl, found at $BUILTIN_SCRIPTS.

- Right-clicking on a hover label and selecting Edit shows an interactive snapshot in the Hover Label Editor. Click an area of the snapshot to open that section of the Hover Label Editor.

Import and Export

- A pipe (|) now separates words within a multiple response in the .sav file’s SPSS label (as in “detergent|liquid”). To change the delimiter, run the following JSL: Preference(SPSSMultiResponseDelimiter(":"), where the colon represents the delimiter that you choose.

- To view a PDF file in portrait style, deselect Horizontal layout.

- When XML or JSON data are shown in the script editor, and you select Edit > Import as Data, the following occurs: If nothing is selected in the file, then the import is based on the file extension. If text is selected, then JMP attempts to parse the data as XML or JSON. Otherwise, the data is treated as CSV data.

Interactive HTML

- You can now zoom and pan in many JMP graphs.

- In Graph Builder, the Order By option for a categorical variable is supported in interactive HTML.

- In Functional Data Explorer, the FPC Profiler is supported in interactive HTML.

- In bubble plots, you can hide the Time label before exporting the report or graph to interactive HTML.
• In heatmaps, the following features are supported in interactive HTML:
  – date-time axis ticks
  – labeling by the percent of total values
  – value ordering in the Color role
• In treemaps, the following features are supported in interactive HTML:
  – proportional highlighting
  – the Order By option for a categorical variable
• Properly formatted hyperlinks in JMP reports appear as links in interactive HTML.
• Labels are generally supported in bar charts. However, labels with custom formatting are not supported. They cause static bar charts.
• You can add custom marker shapes resulting in a static HTML chart.
• Marker sizes in interactive HTML now match what appears in JMP.
• Reports from different platforms that are sharing a column switcher can be published to JMP Live by adding them to a dashboard first.

Journals

• Journals include a toolbar for adding several display boxes onto the journal (for example, text boxes, tab page boxes, and script boxes).
• When you add open files, the log is no longer included in the journal.
• Blank journals show instructions on how to get started with creating a journal.

Making Binning Formula

• The Make Binning Formula utility includes many new features, such as an interactive histogram with an optional scatterplot; resizing handles on histograms; new algorithms for setting cutpoints; and access to custom binning in any column list that supports transform columns.
• The Fill using Bin Count red triangle option specifies a start, end, and a bin count. JMP divides the space between the start and end equally by the bin count.
• The Fill using Jenks Natural Breaks red triangle option specifies a bin count and creates bin cutpoints so that the variance within each bin is minimized and the variance between the bins is maximized.
• After you create a formula column, you can edit the formula by right-clicking on the column header and selecting Edit Binning Formula. This reopens the Make Binning Formula window. To update the binning formula column, edit the cutpoints and click Update Column.
• Right-click the histogram to select options that add or remove cutpoints, show counts, and show percents.

Preferences

• Click the Reset All button in the lower right corner (Windows) or lower left corner (macOS) of the Preferences window to restore the defaults for all preferences.

• In the Recode preferences, **Sort style** specifies how values are initially sorted. New Value sorts in ascending order by the new value. This is the default value. Old Value sorts in ascending order by the old value. Count sorts in descending order with the most common values at the top.

• In the Graphs preferences, the new JMP Blue Red Green theme is available in the Categorical Color Themes in the Qualitative column. This theme is the same as the JMP Default Theme but uses the Graph Builder color order.

• In the Graphs preferences, new Sequential and Bad to Good color themes are available for data that don't have a meaningful mid-point, such as Process Screening and the DOE color map. The new Stoplight Bad to Good and Universal Bad to Good support color deficiency.

• In the Styles preferences, the Shape Boundary Color is available in the Colors section.

Projects

• Self-contained projects provided in JMP 16 are a better way to share a project. All the files in the project can be saved to the project file. You can simply share the project file and it contains everything the user needs to access all files in the project.

• In the Project Settings, you can add a JSL script that will run each time a specific project is opened.

• When you open a Data Filter, it can now dock inside the project window.

• Opening an image file from a project opens in a project tab.

• New preferences enable you to specify the following features:
  – automatically create a new, empty project each time JMP starts
  – whether to use the project log or the JMP log
  – which tool panes initially appear in the project
  – a template to use for new projects
  – open files from Windows Explorer or Mac Finder in an open or new project
Recode

- The following column properties are updated when you recode a column: Value Labels, Value Scores, Value Order, Value Colors, Supercategories, Coding, and Missing Value Codes.
- Open or close all groups by right-clicking in Recode and selecting Open All Groups or Close All Groups.
- When a column has a Value Order property, you can see the default value ordering in Recode by clicking the New Labels column header until the sort is removed.
- The formula saved from Recode is easier to read.
- The Value Label column header includes a red triangle menu that gives access to several options that you might use to recode value labels.

Sample Data

- Design Experiments/Metacrate Limit of Detection DOE.jmp demonstrates the new detection limits feature in DOE.
- Quality Control/Chemical Reactor Process.jmp demonstrates the new Model Driven Multivariate Control Chart (MDMCC) platform.
- The following sample import data files are now Microsoft Excel .xlsx files: Big Class.xlsx, Demand.xlsx, Sandwiches.xlsx, Savings.xlsx, Solubil.xlsx, and VA Lung Cancer.xlsx.
- Big Class Families.jmp includes a new Hexagonal Heat Map with Label Viewer script. This script demonstrates hexagonal binning for heat maps. The script also demonstrates the Graphlet Preset, Label Viewer, which shows how to display multiple images in a hover label.
- Quality Control/Clips1.jmp and Clips2.jmp include new Exponentially Weighted Moving Average (EWMA) Control Chart scripts.
- Prostate Cancer.jmp demonstrates Fit Partial Least Squares and Generalized Regression.
- The Loading plot script in Quality Control/Steam Turbine Historical.jmp uses PCA instead of the Multivariate platform.
- Chips.jmp demonstrates Text Explorer Sentiment Analysis.
- Times Series/M3C Quarterly Wide Format.jmp is a wide version of M3C Quarterly.jmp sample data table.
- The Statistical Thinking for Industrial Problem Solving course uses sample data tables that are installed in the JMP installation folder’s samples/STIPS folder (Windows) or /Library/Application Support/JMP/16/Samples/STIPS (macOS).
Tabulate

- The **Order by count of grouping columns** option can now be turned off for a specific column. You can turn off the option from the report table by right-clicking the column and deselecting **Order By Count**. You can also turn off the option in the saved script. If the option is selected, all the grouping columns are sorted by count.

Tools

- The ruler tool lets you drag a ruler on a graph to measure distances. Select **Tools**, click the ruler, and then drag it over the graph.

Transform Columns

- Transform columns now support dependent column references.
- You can specify the step size in the Row > Lag Multiple transform.
- The By group setting is now removed when the By variable column is deleted.

JMP Live

- The publishing process from JMP has been updated. In addition to creating a new post, you can also update an existing post, or add a post to an existing folder.
- The File > Publish > Manage Connections window is a centralized place to create and manage JMP Live connections for use in publishing and scripting. During publishing, if you do not have a connection created, you are prompted to create one in the Manage Connections window.
- Interactively or through JSL, you can update just the data for a post instead of republishing the entire post.
- You can receive notifications of control chart warnings from JMP Live. These notifications are sent on a post that contains control charts with warnings (if the post has enabled notifications for control charts). These notifications are sent to the publisher of the post and to any members of a group that the post is shared with (if the group has enabled notifications for control charts).
- People can comment on and bookmark posts within a folder.
- Post lists are now sorted by most recently updated, rather than by most recently created.
- In addition to getting real-time updates and alerts for comments, you will also get them on posts and notifications.
• JMP Live administrators can set up an announcement banner that appears to all JMP Live users. Users can dismiss the announcement. If the administrator changes the announcement, it appears again.

• The user interface has been enhanced, especially in Groups, User Profile, and Search.

• JSL scripting has been improved. You can now update the data behind a JMP Live report, replace the contents of an existing JMP Live report, delete reports in a JMP Live folder, and more.

• The default value for allowing anonymous access to JMP Live has changed. In JMP 15.2, the default value was on (selected). In JMP 16, the default value is off (deselected).

Basic Analysis

This section describes new features and enhancements to the general analysis platforms. For details, see the Basic Analysis book.

Distribution

• The Distribution platform can now fit Student’s $t$ distribution.

• The Show Within Capability option enables you to hide estimates of within sigma in the Distribution Process Capability report.

Oneway

• You can now hide the quantile labels in the Normal Quantile Plot.

• The Equivalence Test now includes an option to use unequal variances.

• When a Block variable is specified and the cell counts are unequal, the Oneway report contains Fit Model Standard Least Squares output to accommodate the blocking.

Text Explorer

• **Sentiment Analysis** in Text Explorer enables you to identify sentiment terms in document using lexical analysis and scores documents for positive, negative, and overall sentiment. The Sentiment Analysis feature includes basic natural language processing (NLP) support. (English only)

• **Term Selection** in Text Explorer enables you to identify which terms best explain different responses.
• You can now use the Regular Expression Editor without launching the Text Explorer platform. Select a data table column that contains text and select Cols > Utilities > New Column by Text Matching.

Graphing

This section describes new features and enhancements in the graphing platforms. For details, see the Essential Graphing book.

• New features have been added to the Gradient legends used for contours and other graph types:
  – The Fill option for contours determines how the endpoints of the range are handled when computing the contours.
  – A new scale type of Custom is available in addition to Linear, Log, and the traditional scale types.
  – In the contours for discrete data, you can customize the color at a specific level.
  – The custom legend previously used in Contour Plot is now replaced with the standard gradient legend. Some red-triangle menu items, such as Color Theme and Reverse Colors, have been removed in favor of using the Gradient Settings window for these options. Scripts are expected to be closely compatible.
  – The Graph Builder Contour element with a color variable is also updated to use the new Fill option “Above Below” by default.
  – Other platforms that use contours include these new options but default to their traditional behavior.

• Legends across JMP have been standardized and enhanced.

Graph Builder

• Press Ctrl while using the crosshairs tool to show the crosshairs on the other graph panes.
• You can now select the Unselected Faded option to fade the unselected data in bar charts and heat maps. This option is on the Graphs page in the Fill Section Mode preferences. In addition, Fill Selection Fade specifies the percentage of fade to apply to the fill. You can also set the Fill Selection option on the right-click menu of a frame.
• You can now set variable width box plots or bar charts using the right-click menu of an axis for a categorical grouping variable.
• You can now select a notched box plot from the red triangle menu.
• You can now order the elements in a graph by a continuous variable not used in the plot. You can set the summary statistic used for the ordering.
• The jitter options have been extended to include a density random jittering that places markers randomly within the bounds of a violin plot.
• You now have control over date-time resolution from the axis right-click menu. This allows you to bin date/time data by say month, or day.
• Heat maps now support a size variable, hexagonal shape for continuous variables, and label formatting.
• Custom number formats and precisions in labels are available for Treemap, Heatmap, Mosaic and Pie elements.
• The Size variable can now be customized from a right-click menu.
• Labels on bars can now be formatted and repositioned.
• Contours and box plots can now be offset when grouping variables are used.
• Gradient missing color can now be customized.
• The format of a summary statistic in a caption box can now be customized.
• Line elements can now be labeled from legend right-click menus.
• Legends can now be positioned by dragging to the desired location.
• Subtitles, axes, and axes titles can now be removed.
• Value orders set in graph builder for categorical variables can now be saved to the column property. Column properties can be edited from graph builder.
• The smoother element now has the following methods available: Spline, Local Kernel, Moving Average, and Moving Box. For all methods except Spline, the Smoother red triangle menu now provides options to specify the weight function and method used to define the local region for the fit.
• Summary statistics now include median absolute deviation and cumulative sum.
• You can now add a line element to a parallel plot to display a summary relationship across the parallel plot.
• In Treemap, you can now specify ordering variables for the x and axes. Controls allow you to turn off color and size labels.
• Caption boxes can now display multiple statistics.
• Map shape files for Korea and Australia are now shipped with JMP.
• You can create your own marker shapes in Graph Builder. In the Points panel, select **Set Shape Expression** and enter the JSL expressions for the marker. Select **Set Shape Column** and select the column for the marker.
• Specifying **Set Shape Column** in the Points red triangle menu is an alternative to specifying **Use for Marker** in the data table.
• Zoom buttons appear inside any display frame that contains a geodesic projection. The buttons are shown only when the cursor is inside the frame.
Ternary Plot

- The Fit to Window option determines whether the plot is resized as you resize the JMP window.

Treemap

- If you use the Treemap platform or run a treemap script, the output appears in Graph Builder by default. You can change the output to appear in the Treemap platform using preferences.

Profilers

This section describes new features and enhancements in the Profiler platforms. For details, see the Profilers book.

Profiler

- There are now animation controls that enable you to easily cycle through a variety of factor settings in the prediction profiler.
- Additional options are available for you to specify for the genetic algorithm. The genetic algorithm is only used for optimization with disallowed combination or when extrapolation control is turned “on” or “warning on”. These options appear only in the dialog in these cases.

Design of Experiments

This section describes new features and enhancements in the DOE platforms. For details, see Design of Experiments Guide.

- A new platform, MSA Design, enables you to create a measurement system analysis design and provides diagnostic measures for evaluation.
- A new platform, Sample Size Explorers, enhances JMP’s sample size capabilities. Calculators are included for power, intervals, and reliability demonstrations. There are 17 calculators covering means, proportions, and variances.
- DOE now supports detection limits to facilitate censored modeling in JMP Pro.
- DOE now supports functional responses to facilitate the use of the FDE platform.
Highlights in JMP 16

New Features

Fitting Linear Models

- DOE Mixture designs now support simplex lattice and simplex centroid designs for factors with lower bounds.
- DOE Diagnostics now supports the ability to solve for power.
- The Accelerated Life Testing platform now uses standard deviations and correlations instead of the prior variance matrix.
- The Accelerated Life Testing platform now reports the asymptotic variance of the log-failure probability scaled by the log-probability itself for enhanced numerical stability.
- The Accelerated Life Testing platform now uses the Quantile models as the default.
- Covariate rows may now be repeated in a design.
- There is now a hotspot in Design Diagnostics to use Bayesian information for estimating “if possible” effects. If any main effect is set to If Possible, then only Bayesian information is used.
- The Profiler now recognizes disallowed combinations that are created in the DOE platforms.

Fitting Linear Models

This section describes new features and enhancements in the Fit Model personalities. For details, see the *Fitting Linear Models* book.

- The new Target Level column property can be used to specify the level of interest in binary logistic regression models.

Generalized Regression

- You can now save the distribution and survival formulas for models in Generalized Regression. Survival formulas are available only for continuous response distributions.
- You can now specify censoring for a response column in Generalized Regression using the Detection Limits column property.

Mixed Model

- Confidence intervals for linear combinations of variance components are now available.
- You can now save marginal prediction intervals and conditional confidence intervals for G-side models.
New Features Highlights in JMP 16
Predictive and Specialized Modeling

Standard Least Squares

- Confidence intervals for contrast estimates are now available.
- You can now save the externally Studentized residuals to a new column in the data table.

Predictive and Specialized Modeling

This section describes new features and enhancements in the advanced Modeling platforms. For details, see the Predictive and Specialized Modeling book.

Boosted Tree

- There are new default values for some tuning parameters in Boosted Tree.

Explore Missing

- The Automated Data Imputation (ADI) utility can now be implemented on categorical data.

Explore Outliers

- Robust PCA Outliers has replaced Multivariate Robust Outliers.
- A table that contains the 20 observations with the largest distances from their $K$th nearest neighbor has been added to the K Nearest Neighbors Outliers report.

Explore Patterns

- The Univariate Summary report now contains a Spec Limits Distribution summary table if at least one of the Y columns has a Spec Limit column property and the Distribution wrt Spec Limits option is selected. This table shows the columns that have a statistically significant number of observations outside of the specification limits.

Fit Curve

- The Generalized Regression platform can be launched within the Fit Curve Platform to determine how supplementary variables affect the response. When a grouping variable and at least one supplementary variable is specified in the Fit Curve launch window, a
Highlights in JMP 16

New Features

Predictive and Specialized Modeling

generalized regression model can be fit to each parameter of the nonlinear model using the supplementary variables as model effects.

Make Validation Column

- A Make Autovalidation Column option is now available in the Make Validation Column launch window. This option creates a new data table that contains a duplication of the rows in the original data table concatenated to the rows in the original data table.

Model Comparison

- Model Comparison now contains an optional Decision Thresholds report, which enables you to choose a threshold probability using the distribution of the fitted probabilities and various graphs of classification accuracy.

Model Screening

- Model Screening is a new platform that enables you to quickly run multiple predictive models and compare the results in one report. Measures of fit are provided for each model along with overlaid diagnostic plots.

Nonlinear

- The covariance matrix for the parameter estimates is now available in the Nonlinear report.
- The Save Estimates to Table options saves the parameter estimates to a new data table.

Predictor Screening

- You can now set a random seed in the Predictor Screening launch window.

Process Screening

- You can color the cells in the data table that correspond to values that are out of spec using the Color Out of Spec Values option.
- If the subgroup size for a process is 1, the chart now automatically switches to an Indiv and MR chart.
- The denominator of the Alarm Rate is now the number of non-missing subgroups.
• When Control Chart Builder is launched from within Process Screening, only the tests selected in Process Screening are sent to Control Chart Builder. Tests that have been turned off are not sent.
• You can use KSigma in the launch window to specify the value that is multiplied by sigma in the calculation of the control limits.

Response Screening

• Use the Select Where option to select specific responses in the Result table that correspond to a particular condition.

Support Vector Machines

• Support Vector Machines now fits a range of parameter values for each kernel and identifies the best model fit. This is available through the Tuning Design option.
• The Support Vector Machines platform can now fit support vector regression (SVR) models to continuous responses.

Time Series

• State Space Smoothing models are now available in the Time Series platform.
• The Show Box-Cox Transformation Plot option enables you to view the transformed time series for different values of Lambda.
• You can transform your data prior to analysis using a Box-Cox transformation with a specified lambda value. The platform fits models using the transformed data and then makes forecasts in the original scale.
• The Combine and Save Forecasts from Models option creates a new data table with the combined results from all model fits in the report.
• Time Series data can now be divided into a training set and a holdback set. Models are fit on the training data and forecasts are made on the holdback data to assess the model performance.
• You can now remove individual fits and reports using the Remove Fit red triangle menu option.

Time Series Forecast

• The best fitting State Space Smoothing model can be chosen using a specified information criterion or by assessing the forecasting performance on a holdback set.
Multivariate Methods

This section describes new features and enhancements in the Multivariate Methods platforms. For details, see the Multivariate Methods book.

Discriminant

- Profilers are now available in the Discriminant platform.

Factor Analysis

- The Kaiser-Meye-Olkin (KMO) test is now available in Factor Analysis. The test is an indicator of the proportion of variance that might be common variance, potentially due to underlying factors.
- The Bartlett’s Test of Sphericity is now available in Factor Analysis. The test evaluates whether a correlation matrix is significantly different from the identity matrix.

Partial Least Squares

- You can now launch the Model Driven Multivariate Control Chart (MDMCC) platform from the Partial Least Squares report. In the MDMCC launch window, the score formulas for each X Score are assigned as the process columns.
- Several performance improvements have been made to the algorithm used to fit Partial Least Squares models, improving computation time for large data sets. This algorithm is called Fast SVD and is on by default. The former algorithm is called Classic SVD and is accessible through the Partial Least Squares red triangle menu.

Structural Equation Models

- You can now use summarized data (such as correlation or covariance matrices) to fit structural equation models.
- Several additional modeling shortcuts have been added to the Model Shortcuts in the Model Specification report. The new shortcuts include: confirmatory factor models, mediation models, the ability to covary exogenous or endogenous variables, and additional growth curve model shortcuts.
- Statistics and visualizations have been added to assess the reliability and validity of constructs in confirmatory factor models that do not have covariances among unique factors. The new statistics include coefficient omega, coefficient H, indicator reliability, average variance extracted by latent variables, and squared latent variable correlations.
New Features

Highlights in JMP 16
Quality and Process Platforms

- The launch window now contains options to suppress the estimation of the unrestricted and independence models.
- You can now save factor scores that are estimated using the Bartlett method.
- You can now compare models that are fit in the same report using the **Compare Selected Models** option. This option performs a chi-square difference test and shows the difference in CFI and RMSEA indices.
- Profilers are now available for structural equation models.
- Options have been added to copy and paste a specific model or properties of a path diagram.
- New options are available to add or remove manifest variables from the existing model.
- New options for saving prediction formulas and observational residuals have been added to the Save Columns menu.
- Path diagrams of fitted models now illustrate the proportion of variance explained in endogenous variables by shading the diagram’s nodes proportionally to the R-squared values. The precise R-squared values can also be printed inside the diagram nodes.
- Fonts in the path diagram can now be customized.

Quality and Process Platforms

This section describes new features and enhancements in the Quality and Process platforms. For details, see the *Quality and Process Methods* book.

Control Chart Builder

- The new Test Excluded Subgroups option enables you to specify that entirely excluded subgroups be excluded from tests. This option is selected by default to match the behavior in previous versions of JMP.
- The Show Upper Limit and Show Lower Limit options enable you to show or hide the upper and lower limits independently of each other. When a limit is hidden, tests related to that limit are not shown in the control chart or in the Alarm Report.
- The Show Limit Labels option enables you to place control limits in control charts.
- The Alarm Script option can now report the label of the phase during which a failure occurred.
- The AIAG (Ppk) Labeling in Process Capability preferences also apply to Control Chart Builder.
- You can now use the Graph Spacing option to adjust the spacing between control charts.
CUSUM Control Charts

- You can now adjust the acceptable range for the Y variable to update the imputed $k$ parameter in the CUSUM chart. This is particularly helpful when the testing interval is more frequent, which can result in a much shorter practical average run length.
- Alarm scripts are now available for CUSUM control charts.

EWMA Control Charts

- The EWMA Control Chart platform creates exponentially weighted moving average (EWMA) charts, which can be used to detect small shifts in a process. Each point on an EWMA chart is the weighted average of all the previous subgroup means, including the mean of the present subgroup sample. The weights decrease exponentially going backward in time.

Measurement Systems Analysis

- You can now specify that interactions be included in the Reproducibility calculation within the EMP Gauge R&R Results report. Select the Include Interactions in Reproducibility platform preference, which is located in File > Preferences > Platforms > EMP Measurement Systems Analysis.

Model Driven Multivariate Control Charts

- The IR chart x axis and the text label in the bar chart will reflect the time ID, if specified.

OC Curves

- A new OC Curve platform is now located under the Quality and Reliability menu. Curves are available for XBar Shewhart, P, NP, C, and U charts. In addition there are OC curves for single and double acceptance sampling plans.

Reliability and Survival

This section describes new features and enhancements in the Reliability and Survival platforms. For details, see the Reliability and Survival Methods book.
- The value of the Boltzmann constant used in Arrhenius formulas has been updated from 11605 to 11604.5181215503.
Fit Life by X

- New residual versus fitted plots can be used to validate the distributional assumption for the different levels of the accelerating variable.
- The scatter plot now supports a Box-Cox transformed axis when the Box-Cox relationship is specified.
- The Custom Estimation option now includes estimates of the mean time to failure (MTTF) and mean remaining life (MRLF) for positive supported distributions.

Life Distribution

- Two tests (Log-Rank and Peto-Peto) have been added to the tests of group homogeneity in the Life Distribution - Compare Groups report.

Parametric Survival

- The Estimate Quantile option replaces the Estimate Time Quantile option. The new option uses the probability for the quantile, rather than the survival probability.

Reliability Block Diagram

- The Generate Algebraic Expression Data Table option produces a data table with a formula column that contains the JSL formula for the system reliability algebraic expression.

Reliability Growth

- The plots in the Crow-AMSAA report now use a log-scaled date axis when the time column is timestamped.

Repairable Systems Simulation

- You can now use the Turn On System Exemption option to exempt blocks from being turned on by the Turn On System option.
Consumer Research

This section describes new features and enhancements in the Consumer Research platforms. For details, see the Consumer Research book.

- A False Discovery Rate (FDR) \( p \)-values option has been added to categorical summary reports for Homogeneity Tests (Pearson and LR), Rate Tests Each, and Binomial Tests Each. The FDR \( p \)-values are based on the Benjamini and Hochberg methodology.

Scripting

This section describes new features and enhancements in the scripting area. For details, see the Scripting Guide and the JSL Syntax Reference.

- In the script editor, comments can be automatically folded, and now code that spans multiple lines are included. In the Script Editor preferences, select Code Folding.

- In the script editor, line numbers are automatically displayed. The Script Editor preference Show line numbers in script editor windows is selected by default. You can also show line numbers in any script editor box (such as in the Scripting Index) by selecting the preference Show line numbers in script editor boxes.

- When you reformat a script, each line is filled with arguments instead of having one argument per line. This happens only when none of the arguments have children or contain multiple statements.

- When you edit a script, you can type in multiple rows at once. Hold down Alt and drag the cursor to place the cursor across multiple rows of text, and then type the code. Previously, the new text was added only to the last line.

- Lineup Ruler Box() sets the column widths of the Lineup Boxes that the ruler box contains. Unlineup Box() temporarily suspends the column layout of a lineup box. The child of the unlineup box is stretched to span all columns of the lineup box.

- Three new messages enable scrolling in ListBoxBox():
  - Show Item(index) scrolls the list box to make sure that the requested item is visible.
  - Set First Visible Item(index) scrolls the list box so that the requested item is the first visible item.
  - Get First Visible Item(index) returns the index of the first visible item.

- All SI prefixes, from \( 1e-24 \) to \( 1e+24 \), are available.

- Custom Format() now allows the customization of column width and decimal places.
The new VP Tree() function uses the vantage-point tree algorithm to produce a table that is used for efficiently looking up nearest neighbors. This algorithm is particularly useful for wide data problems.

The new Robust PCA() function performs a sequence of singular value decompositions and thresholding steps to decompose the data matrix into a low-rank matrix and a sparse matrix of residuals.

Three new functions enable you to efficiently iterate through containers (lists, matrices, or associative arrays):

- For Each() evaluates a JSL expression in each iteration.
- Filter Each() returns a subset of the container based on a Boolean result of the evaluation of a JSL expression in each iteration.
- Transform Each() returns a container that is the result of the evaluation of a JSL expression in each iteration.

The new Get Locale Setting() function returns the current separator settings from the Locale Format Settings in JMP Preferences.

If a data table has been locked through the table panel’s red triangle menu or the Lock Data Table() function, Get Edit Lock() returns a list of data table operations that are locked.

New rows of data can be added when the Modify Cells edit lock is on.

Two platform reports can share a Column Switcher. The new message called Link Platform(platform) takes a reference to a platform that should be controlled by the column switcher. You can link as many platforms as you want, and the platforms don’t have to be in the same window.

New messages are available to query and modify items in legend displays and models:

- graph builder << Get Legend Display returns the legend display box for the graph that can be modified or queried.
- graph builder << Get Legend Server returns an object that holds information used by the legend display and corresponding display segs in the graph.
- The legend display server Get Legend Item message returns a legend model item from a legend display server given a unique model ID and index into the model’s items. Get Legend Items returns a nested list of all legend model items from a legend model.
- The legend display box Get Item message returns a legend item that can be modified or queried. The Get Items message returns a list of all legend items that can be modified or queried.
- Legend display item messages control the appearance of the legend itself. The messages include Get Type (returns the type of the legend item); Get Position
(returns the sequential position of a legend item); Get Label (returns the legend item label); Set Label (sets the legend item label); and Set Visible(Boolean).

– Legend model items have additional properties that affect the appearance of the linked display seg. Get Type returns the type of the legend item. Additional messages include Get and Set Label; Get Fill Color; Get Pen Settings; Get Gradient Settings; Get Marker Size Settings; and Set Properties.

• The keyboard shortcut for commenting a block of code is Ctrl+/ (Windows) or Cmd+/ (macOS). The keyboard shortcut for uncommenting a block of code is Ctrl+Shift+/ (Windows) or Cmd+Alt+/ (macOS).

• Get Select Indices as Matrix() returns the matrix for a check box made from a list.

• In Write() for zip archives, Replace creates the file with a temporary name, deletes the old file, and renames the temporary file to the existing name.

• Save Window to Report saves the current report window to a JMP report file (.jrp).

• The new Heat Image() function takes a matrix and color theme or gradient properties and returns an image that maps matrix values to colors.

• Use the same syntax when changing the format of text in a number col edit box and number col box. Previously, the number col edit box formatting syntax was less intuitive.

• Creating multiple axes is more convenient now. Assign a unique Scale ID() and Side() to each axis. Add graphics scripts to the frame box to draw graphs inside the frame.

• Use Get Stretch and Set Stretch to get and stretch display boxes instead of the deprecated Get Autostretch and Set Autostretch.

• Tabs can now be shown on the left, right, or bottom of the tab box.

\[\text{Set Title Location( "Top" | "Bottom" | "Left" | "Right" | "Auto" );}\]

• Newer Unicode characters (such as emojis) now appear correctly inside text boxes.

• New font messages have been added to tab page boxes: Set Font, Set Font Name, Set Font Scale, Set Font Size, Set Font Style, and the corresponding Get messages.

• Send Set Click Sort(1) to a column in a table box to let the user click the header and have the column sort automatically.

• The Set Scale message enables you to specify the scale for the title of a plot col box.

• The ISO Year() function is available.

• Change the axis line thickness using the Line Width argument in the dispatch code.

\[\{\text{Label Row( \{Line Color( 6 ), Line Width( 2 )\} )}\}\]